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Chapter 1: Remote Communication Setup
Chapter 1
Remote Communication

Setup

Before You Get Started with Remote Communications

Before you get started installing and configuring your system for 
remote communications, ensure that you have all of the items in the 
following checklist.

Installed Software
Continuum CyberStation
Modem Specific Drivers (The modem being used on the Workstation 
must be on the Windows Hardware Compatibility List)

Note:  Ensure that you do not have “Proxy Server” enabled on your 
workstation. This may cause contention issues.

Installed Hardware
Continuum Controller that supports remote access communications 
(called RAS) with an Andover Continuum modem or Schneider Electric 
approved external modem. (The only approved external modems are 
US Robotics Courier V.Everything 56k External, or Viking V.90 56k 
External)
Internal or external modem (Must be on the Windows Hardware 
Compatibility List)
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Chapter 1: Remote Communication Setup
Privileges
You must be able to logon to the Windows with administrative 
privileges (for dialing in purposes)
You must be able to logon to the remote controller with administrative 
privileges

Communications
An available dedicated analog phone line for the remote controller or a 
direct cable connection
The remote controller’s area code and phone number

Conventions Used in this Guide

Throughout the following pages the term “Windows” applies to any 
version of Microsoft Windows that is supported for the version of 
CyberStation you are using. Any serious differences that exist between 
versions are identified.

Throughout the following pages the term “workstation” refers to a 
personal computer (PC) containing a Windows operating system with 
Continuum CyberStation installed and running.
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Setting Up Location, Modem, and Routing

In order to set up remote communications between a local workstation 
and a remote controller you must configure modems and dialup 
connections through a comm port at both the workstation and the 
remote controller. We begin performing the follow steps on the 
workstation.

Windows location configuration
Windows modem configuration
Window routing and remote access connection services

Windows Location Configuration

Follow the steps below to create a location in a Windows system.

Step 1: Click on Start in the Windows task bar and select Settings 
and then Control Panel.

Step 2: Double click or right click on the Phone and Modem 
Options icon.

Step 3: A Location Information dialog appears prompting you for 
the telephone number location information. Enter the 
appropriate information about your location and click OK.
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Note:  This step is only necessary the first time you open Phone and 
Modem Options. Once you create the location you will not be 
prompted again.

Step 4: The Phone and Modem Options editor appears.

In the Dialing Rules tab, click the Edit button to open the 
Edit Location dialog. This dialog allows you to specify when 
to use the area code during dialing. It also allows you to enter 
other phone call-specific information, such as the use of a 
phone calling card.
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Step 5: Enter any necessary information into this dialog and click OK 
when complete. You are returned to the Phone and Modem 
Options dialog.

Windows Modem Configuration

Follow the steps below to add a modem in a Windows system.

Step 1: From the Phone and Modem Options editor, select the 
Modems tab and click the Add button.

Step 2: The Add/Remove Hardware Wizard dialog appears asking, 
“Do you want Windows to detect your modem?” Read and 
follow steps 1 and 2, then click the Next button.
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Step 3: Once Windows detects your modem, the Found New 
Hardware Wizard screen appears. Click the Next button 
and let Windows find a driver for your modem. Since Windows 
detect the modem, you do not have to select a port.

Step 4: When the process is complete, you receive a message stating 
that the modem has been set up successfully, and you are 
given one more chance to change the settings. If you are done, 
click Finish.

The Modems tab of the Phone and Modem Options editor appears 
with the specified modem listed in the Modem column.
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Step 5: Click the modem to highlight it, and then click the Properties 
button. The Modem Properties editor appears.

Step 6: In the Modem tab, set the Maximum Port Speed. For best 
performance, set this to the highest rate that the PC supports.

Step 7: Select the Diagnostics tab and click the Query Modem 
button to verify that the modem is functioning.

Step 8: Click OK to return to the Modem Properties editor.
Andover Continuum Remote Communication Configuration Guide 15



Chapter 1: Remote Communication Setup
Step 9: Click OK on the Modem Properties editor to close and save 
the changes. The modem installation and configuration are 
now complete.

Routing and Remote Access and Network Connections 
Services

After the location and modems have been installed and configured, you 
must set up the Routing and Remote Access and Network Connection 
services to start automatically when Windows starts. This ensures that 
all of the required services start automatically in the event that the 
workstation needs to be restarted.

Perform the following procedure to setup these services.

Step 1: At the workstation, select Start then select Control Panel.

Step 2: On the Control Panel screen, select Administrative Tools.

Step 3: Select Services from the Administrative Tools menu.

Step 4: On the Services dialog, scroll to Routing and Remote 
Access and double click it.
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Step 5: On the Routing and Remote Access Properties (Local 
Computer) editor, select Automatic from the Startup Type 
dropdown menu.

Step 6: Click the Start button if the service has not already been 
started.

Step 7: Repeat steps 1, 2, and 3 from the beginning of this section.

Step 8: Back at the Services dialog, locate Network Connections 
and double click.

Step 9: On the Network Connections Properties (Local 
Computer) editor, select Automatic from the dropdown 
menu in the Startup Type field.

Step 10:Click the Start button if the service has not already been 
started.
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Chapter 2: Configuring the Remote Network and Controller
Chapter 2
Configuring the Remote
Network and Controller

Overview

The next step is to configure remote networks and remote controllers. 
Each remote site that has a CX controller that can be dialed into must 
reside on its own network in Continuum. The configuration of remote 
communications includes:

Creating the remote network
Creating the remote controller
Creating the network dialup object
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Creating the Remote Network

Use the following steps to create a remote network.

Step 1: Open Continuum Explorer and select Networks from the 
quick pick toolbar.

Step 2: Right click on Root and select New and Network.
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Step 3: From the New dialog, give the new network object an 
appropriate name (“RemoteSite” is used in the example shown 
below) and click Create.

Step 4: The Network editor appears. Enter a description (optional). 
Adjust the time zone setting based upon the time zone of the 
network location. Ensure that the Controller to 
Cyberstation Dbsync check box is deselected (unchecked).
Click Apply.

Once the network object has been create, it appears in the navigation 
(left) pane of the Explorer. If it does not appear, refresh the screen.
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Creating the Remote Controller

Now that the remote network has been created, you will need to add 
the remote controller(s) to the network. Follow the steps below to create 
a remote controller.

Step 1: Right click on the red Workstation Status icon in the 
Continuum icon tray, and select Go Offline.

Step 2: In the Explorer’s navigation (left) pane, right click on the 
remote site network object that was created earlier and select 
New and InfinityController.
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Step 3: In the New dialog supply an appropriate name for the 
controller and click Create.

Step 4: The InfinityController editor appears. On the General tab, 
enter an optional Description, the controller’s ACCNetID 
number, select the Controller Type and click OK.
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Step 5: Select the Network tab on the InfinityController editor.

Step 6: Make sure the Controller to CyberStation DBSync 
checkbox is unchecked. For a single controller, with or without 
a Network Interface Card (NIC) and with a modem on the 
remote site, set the controller’s IP Address, Subnet Mask, 
Default Router, and PPP IP Address as follows:

Table 1  Single Controller with or without a NIC

Item Controller with NIC Controller without 
NIC

IP Address Specify the 
appropriate IP address 
OR set to 0.0.0.0

0.0.0.0

Subnet Mask Specify the 
appropriate Subnet 
Mask for your IP 
address OR set to 
0.0.0.0

0.0.0.0

Default 
Router

0.0.0.0 0.0.0.0
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Note:  If there is a workstation that has this controller listed in its 
database, the PPP IP Address of this controller must match the 
PPP IP Address for the controller in the database.

For configuring multiple controllers on the remote site, specify an IP 
Address and Subnet Mask that is the same as the gateway controller. 
Refer to Configuring a Remote Site with Multiple Controllers for more 
information.

If you are planning on adding a NIC to a controller on a remote site at 
some point in the future and you want to reserve its IP address now, set 
the network addresses of the controller and the workstation as follows:

Refer to Configuring the Remote Controller for further information.

PPP IP 
Address (see 
note below)

A unique address that 
is in a different subnet 
from your workstation.

A unique address that 
is in a different subnet 
from your workstation.

Table 2  Reserve Controller Addresses for future NIC

Item Controller Continuum 
Cyberstation

IP Address Specify the IP address. 0.0.0.0

Subnet Mask Specify the Subnet 
Mask for your IP 
address.

0.0.0.0

Default 
Router

0.0.0.0 0.0.0.0

PPP IP 
Address

A unique address that 
is in a different subnet 
from your workstation.

A unique address that 
is in a different subnet 
from your workstation.

Table 1  Single Controller with or without a NIC

Item Controller with NIC Controller without 
NIC
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Creating the Network Dialup Object

The network dialup object is created under the workstation object in 
the Network view of the Continuum Explorer. If more than one 
workstation is connecting to the same remote site, each workstation 
requires its own Network Dialup object in order to connect to the 
remote controller at that site.

Each workstation can have many Network Dialup objects, allowing a 
single workstation to contact multiple remote sites. Each Network 
Dialup object is required to connect to a different remote site and needs 
a unique phone book entry. Dialup networking supports as many 
concurrent dialup connections as there are modems connected to the 
workstation.

To create a Network Dialup object:

Step 1: Create the Network Dialup object in the Continuum Explorer’s 
Network view. Right click on the workstation device icon and 
select New and Network Dialup.

Step 2: In the New dialog, supply an appropriate name for the 
Network Dialup object and click Create. 

Step 3: The NetworkDialup editor appears. Enter an optional 
description for the object in the Description field.
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Step 4: From the Network Name dropdown menu, select the remote 
network that was previously created.

The Use this Phonebook File section contains a File Type field and 
a File Name field. The default value for the file type is “System 
Phonebook” and the default value for the filename is grayed out. 
Alternate phonebook files are not supported.

Note:  In the next step you work with the Use this Phonebook Entry 
section where you indicate the actual phone number of the 
connected remote controller. The modem on the workstation 
dials this number and executes any script required to make the 
connection.

Step 5: To create a new phone book entry, click the New button in the 
Use this Phonebook Entry section. The Add Phonebook 
Entry dialog appears. You use it to enter a unique entry 
name, phone number to dial, modem to use to dial the number, 
and a dial script. In Windows, the default dial script is located 
in: \Program Files\Continuum\Ras\acc.scp

Note:  These phone book entries may also be created outside of 
Continuum using the network and dialup connections 
application in Windows.

Step 6: In the Entry Name field, enter a unique entry name.

Step 7: In the Phone Number field, enter a phone number to dial.
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Note:  If you are using a direct serial cable connection, the phone 
number is not required.

Step 8: In the Dial Using field, select the modem from the dropdown 
menu.

Step 9: Leave the Dial Script field at default, \Program 
Files\Continuum\Ras\acc.scp.

Step 10:Click OK.

Step 11:To verify the configuration of the phone book entry, deselect 
the Dial Into CX checkbox on the General tab. Once this is 
deselected, the Configure button is enabled.

Step 12:Click the Configure button.

Step 13:The Network Connections dialog appears. Click the 
Properties button to view the RemoteSiteDialup 
Properties editor.

Step 14:In the General tab, verify the proper modem is listed in the 
Connect using field for dialing into the controller. Also, 
verify that the correct phone number is listed in the Phone 
number section.
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Step 15:Click the Configure button. The Modem Configuration 
dialog appears.

Step 16:Verify the modem speed in the Maximum speed (bps) field is 
set to the highest rate that the PC supports. 

Step 17:Check the following:

Enable hardware flow control
Enable modem error control
Enable modem compression

Step 18:Click OK and return to the RemoteSiteDialup Properties 
editor.

Step 19:In the Phone Number section of the General tab, verify that 
the Area code and Phone Number are correct.
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Step 20:Select Use dialing rules if you need to dial 1 or use an area 
code to dial out. This causes the modem to use the area code 
you typed for your location. Refer to Windows Location 
Configuration for further information.

Step 21:Click the Dialing Rules button and view the location and 
modem options to verify that they are configured properly.

Step 22:In the Number Properties dialog, select Show icon in 
taskbar when connected (optional) to have the modem icon 
appear on your toolbar.

This action displays the icon below when the modem is 
connected to the controller.

Step 23:Click the Options tab on the RemoteSiteDialup 
Properties editor.
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In Windows Vista:

In Windows XP:

Step 24:In the Dialing options area, select Display progress while 
connecting. 
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Step 25:In the Redialing options area, leave the fields at their 
default values. If there is a time in the Idle time before 
hanging up field, set it to never.

Step 26:For Windows Vista Only, click the PPP Settings button, and 
on the PPP Settings dialog, select all the checkboxes and 
click OK.

Step 27:Click the Security tab.

Step 28:On the Security tab, leave the security options at their 
default values and verify that the acc script is selected in the 
Run script field.

Step 29:Click the Networking tab.
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Step 30:For Windows Vista, click Internet Protocol Version 4 
(TCP/IPv4).
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For Windows XP, verify that PPP Windows is selected in the Type of 
dial-up server that I am calling field, then click the Settings 
button.

For Windows XP, select all the checkboxes and click OK.

Step 31:Verify that the File and Printer Sharing and Client for 
Microsoft Networks are NOT selected, and then click the 
Properties button.
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Step 32:The Internet Protocol (TCP/IP) Properties dialog 
appears. Leave the settings as shown (default).

Step 33:Click the Advanced button.

Step 34:The Advanced TCP/IP Settings dialog appears. Leave the 
default settings as shown.
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Step 35:Click OK to save and close the Advanced dialog, Internet 
Protocol Properties dialog, and the RemoteSiteDialup 
Properties editor.

Step 36:Click Close on the Network Connections dialog.

Step 37:You should be back in the Continuum NetworkDialup editor. 
In the General tab, verify that the phone book entry you 
created in an earlier step is in the Entry Name field of the 
Use This Phonebook Entry section.

Step 38:Check the Dial Into CX checkbox. Notice the Configure 
button is now grayed out again.

Step 39:Click the editor’s Dialup tab.

Step 40:Enter information on this tab. The following table describes its 
attributes.

Table 3  NetworkDialup - Dialup Tab

Fields Description

Idle 
Disconnect 
Time

Number of network inactivity 
seconds, before the remote 
connection is dropped. The idle 
disconnect is not affected by setting 
a continuous poll interval.
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Step 41:Click OK to save the object.

Step 42:Right click on the workstation icon and select Go Online.

Alarm 
Interval

Number of minutes until 
Continuum automatically calls the 
remote site to update alarms.

Event 
Interval

Number of minutes until 
Continuum automatically calls the 
remote site to update events.

Active Alarm 
Synchronizat
ion

If selected, Continuum will 
synchronize alarms at the remote 
site at the selected Poll Interval. If 
not selected, Continuum will only 
retrieve Active Alarms once when 
the connection to the remote site is 
established.

Active Event 
Synchronizat
ion

If selected, Continuum will 
synchronize events at the remote 
site at the selected Poll Interval. If 
not selected, Continuum will only 
retrieve Active Events once when 
the connection to the remote site is 
established.

Continuous 
Poll Interval

Number of minutes Continuum will 
wait to poll for Alarm and Event 
information after a connection is 
established. Setting the continuous 
poll interval does not reset the Idle 
disconnect timer.

Table 3  NetworkDialup - Dialup Tab

Fields Description
Andover Continuum Remote Communication Configuration Guide 37



Chapter 2: Configuring the Remote Network and Controller
38 Schneider Electric



Chapter 3: Configuring Windows to Receive Incoming Calls
Chapter 3
Configuring Windows to
Receive Incoming Calls

Receiving Calls on Windows XP

This section describes how to set your workstation to receive incoming 
calls from the controller, and how to set up a controller to dial into a 
Windows XP workstation.

Note:  If you are working with Windows 2003 Server, refer to Receiving 
Calls on Windows 2003 Server.

Step 1: On your Windows desktop, click Start then Control Panel. 
Then double click Create a new connection.
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Step 2: In the Network Connection Wizard, click the Next button.

Step 3: In the Network Connection Wizard dialog, select Set up 
an advanced connection and click the Next button.
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Step 4: In the Advanced Connection Options dialog, select Accept 
incoming connections and click the Next button.

Step 5: Select your modem in the Device for Incoming Connection 
dialog and then click the Next button.
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Step 6: Select Do not allow virtual private connection in the 
Incoming Virtual Private Connection dialog and then 
click the Next button.

Step 7: Select acc (acc) in the User Permissions dialog (this allows 
user acc to dial in), and then click the Next button.

Step 8: In the Networking Software dialog, highlight Internet 
Protocol (TCP/IP), and then click the Properties button.
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Step 9: In the Incoming TCP/IP Properties dialog:

Deselect Allow callers to access my local area network.
In the TCP/IP address assignment section, select Specify TCP/
IP addresses.

Note:  You must enter a valid range that is not within your local subnet 
range.

In the TCP/IP address assignment section, deselected Allow 
calling computer to specify its own IP address.

Step 10:Click OK and then click the Next button on the Networking 
Components dialog.

Step 11:Click the Finish button on the Completing the Network 
Connection Wizard page. 

Note:  Windows will not allow you to change the incoming connection 
object name.

The workstation is now configured to receive incoming calls from 
selected users over its TCP/IP network.
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Receiving Calls on Windows Vista

This section describes how to set your workstation to receive incoming 
calls from the controller and how to set up a controller to dial into a 
Windows Vista workstation.

Note:  If you are working with Windows 2003 Server, refer to Receiving 
Calls on Windows 2003 Server.

Step 1: On your Windows desktop, click Start and then click Control 
Panel.

Step 2: Click the Network and Internet link. Then, click the 
Network and Sharing Center link.

Step 3: Click the Manage network connections link.

Step 4: In the Network Communications window, press Alt + F to 
open the file menu.

Step 5: Click New Incoming Connection.
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Step 6: At the User Account Control prompt, click the Continue 
button.

Step 7: In the Who may connect to this computer? page of the 
Allow connections to this computer dialog, click Add 
someone.

Step 8: In the New User dialog, enter acc in all fields and then click 
OK.

Note:  The password field is case-sensitive. Do not enter acc in capital 
letters.

Step 9: Click Next.
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Step 10:In the How will people connect? page of the Allow 
connections to this computer dialog, select Through a 
dial-up modem.

Step 11:Select the modem you want and then click Next.
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Step 12:In the Networking software allows this computer to 
accept connections from other kinds of computers page, 
select Internet Protocol Version 4 (TCP/IP4).

Step 13:Click Properties.

Step 14:In the Incoming TCP/IP Properties dialog:

Deselect Allow callers to access my local area network.
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In the TCP/IP address assignment selection, select Specify 
TCP/IP addresses.

Note:  You must enter a valid range that is not within your local subnet 
range.

In the TCP/IP address assignment selection, deselect Allow 
calling computer to specify its own IP address.

Step 15:Click OK, then click Allow access in the Networking 
software allows this computer to accept connections 
from other kinds of computers page of the Allow 
connections to this computer dialog.

Step 16:Click Close.
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Receiving Calls on Windows 2003 Server

This section describes how to set your workstation to receive incoming 
calls from the controller and how to set up a controller to dial into a 
Windows 2003 Server workstation.

Step 1: Click the Start button in your task bar.

Step 2: Select Administrative Tools > Routing and Remote 
Access. The Routing and Remote Access dialog appears.
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Step 3: From the Action menu bar, select Configure and Enable 
Routing and Remote Access. The Setup Wizard appears.

Step 4: Click Next. The Configuration dialog appears.
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Step 5: Select Remote Access (dial-up for VPN). Be sure to leave 
all other checkboxes cleared, and click Next. The Remote 
Access dialog appears.

Step 6: Check the Dial-up checkbox, and click Next. The Network 
Selection dialog appears.
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Step 7: Select the appropriate interface, and click Next. The IP 
Address Assignment dialog appears.

Step 8: Select from a specified range of addresses, and click Next. The 
Address Range Assignment dialog appears.
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Step 9: Click New. The New Address Range dialog appears.

Step 10:Enter an appropriate Start IP address, End IP address, 
and Number of Addresses, and click OK.

Step 11:Click Next. The Managing Multiple Remote Access 
Servers dialog appears.

Step 12:Select No, use Routing and Remote Access to 
authenticate connection requests, and click Next.

Step 13:Click Finish.

Step 14:Click the Start button in your taskbar.
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Step 15:Select Administrative Tools.

Step 16:Select Remote Access. The Routing and Remote Access 
dialog appears.

Step 17:In the tree, right click on the local server and select 
Properties. The server Properties dialog appears.
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Step 18:On the General tab, check the Remote access server 
checkbox, and then select the Security tab.

Step 19:On the Security tab, click Authentication Methods. The 
Authentication Methods dialog appears.
Andover Continuum Remote Communication Configuration Guide 55



Chapter 3: Configuring Windows to Receive Incoming Calls
Step 20:Check the Unencrypted authentication (PAP) checkbox, 
and click OK.

Step 21:Select the IP tab of the Properties dialog and check the 
Enable IP routing checkbox.

Step 22:Check the Allow IP-based remote access and demand-
dial connections checkbox.

Step 23:Select Static address pool.

Step 24:Check the Enable broadcast name resolution checkbox. 
Select the PPP tab.
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Step 25:On the PPP tab, check the Multilink connection checkbox, 
and click OK. The Routing and Remote Access dialog 
appears again.

Step 26:In the tree, right click Remote Access Policies.

Step 27:Select New > Remote Access Policy. The New Remote 
Access Policy Wizard dialog appears.
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Step 28:Click Next. The Policy Configuration Method dialog 
appears.

Step 29:Select Use the wizard to set up a typical policy for a 
common scenario.

Step 30:Enter a name in the Policy Name field and click Next. The 
Access Method dialog appears.
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Step 31:Select Dial-up, and click Next. The User or Group Access 
dialog appears.

Step 32:Select User, and click Next. The Authentication Methods 
dialog appears.

Step 33:Check the Microsoft Encrypted Authentication version 2 
(MS-CHAPv2) checkbox. If your network runs operating 
systems that do not support MS-CHAPv2, check the 
Andover Continuum Remote Communication Configuration Guide 59



Chapter 3: Configuring Windows to Receive Incoming Calls
Microsoft Encrypted Authentication (MS-CHAP) 
checkbox.

Step 34:Click Next. The Policy Encryption Level dialog appears.

Step 35:Check the No encryption checkbox, and click Next.

Step 36:Click Finish. 
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Step 37:In the Routing and Remote Access dialog, right click on 
your remote access policy, and select Properties.

The DialinConnection Properties dialog appears.
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Step 38:Click Edit Profile.

The Edit Dial-in Profile dialog appears.

Step 39:On the Authentication tab, check the Unencrypted 
authentication (PAP, SPAP) checkbox.
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Step 40:On the Encryption tab, check the No encryption checkbox, 
and click Apply.

Step 41:Click OK.
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Windows Remote Communication User Configuration

Prior to a controller’s dialing into a workstation, a new Windows user 
must be created on the local workstation. Perform the following steps to 
create a new Windows user.

Note:  If you are using Windows 2003 Server, refer to Windows 2003 
Server Remote Communication User Configuration.

Note:  If your configuration uses a direct serial cable connection (no 
modem), this section is not required.

Step 1: From the Windows desktop, click the Start button, then 
Control Panel.

Step 2: Double click on Administrative Tools, then Computer 
Management and Local Users and Groups.
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Step 3: Highlight Users, click Action and select New User from the 
dropdown menu.

Step 4: In the New User dialog, type in acc in the User name, Full 
name, and Password fields.

Note:  The password field is case sensitive, do not type acc in capital 
letters.
Andover Continuum Remote Communication Configuration Guide 65



Chapter 3: Configuring Windows to Receive Incoming Calls
Step 5: Deselect the User must change password at next logon 
checkbox and check the Password never expires checkbox.

Step 6: Click Create and then Close to create the new user and close 
the dialog.

Step 7: Highlight and right click the new user acc and from the popup 
menu select Properties.

Step 8: Select the Member Of tab.

Step 9: Click the Add button.
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Step 10:The Select Groups dialog appears. Click Advanced.

Step 11:The Select Groups dialog reappears with the advanced 
search options available. Click Find Now.
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Step 12:In the Select Groups dialog, the search results appear. 
Highlight Administrators. Click OK.

Step 13:The initial Select Groups dialog appears. The object name 
displays in the Enter the object names...field. To apply the 
selections, click OK.

Step 14:To exit, click OK.
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Windows 2003 Server Remote Communication User 
Configuration

Prior to a controller’s dialing into a workstation, a new Windows user 
must be created on the local workstation.

Note:  Refer Windows Remote Communication User Configuration for 
further information.

Perform the following steps to create a new Windows 2003 Server user.

Step 1: Click the Start button in your task bar.

Step 2: Select Administrative Tools. The Computer Management 
dialog appears.

Step 3: In the tree, expand Local Users and Groups.

Step 4: Right click Users.

Step 5: Select New User. The New User dialog appears.
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Step 6: Check the Password never expires checkbox, and click 
Create.

Step 7: In the Computer Management dialog, right click on the 
newly created user, and select Properties.

The Properties dialog appears.
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Step 8: On the Dial-in tab, select Allow access and No Callback.

Step 9: Click Apply, and then OK.
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Chapter 4
Configuring and Connecting

to Remote Controllers

Configuring the Remote Controller

Before establishing a dialup connection to the remote site from the 
NetworkDialup object, the CX Controller needs to be configured with 
the correct IP and PPP information. Depending on the model of the 
controller this is done using a command terminal RS-232/ASCII 
interface or through an HTML page served over the Ethernet interface. 
It is beyond the scope of this manual to explain the use of the 
configuration utility for each controller.CX9201, CX94xx, and CX99xx 
controllers are configured using the command terminal interface. All 
other controllers use HTML embedded web configuration pages.

The following information outlines what needs to be configured for 
remote communications to operate correctly. Refer to the appropriate 
document to learn the details of configuring the controller.

Step 1: Set the appropriate COMM port’s default baud rate. For best 
performance, select the highest supported baud rate.

Note:  For CX series controllers, set the default baud to 19200.
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Note:  For the bCX1 series (9640 controller), set the default baud to 
38400.

Step 2: Set the IP address, Subnet Mask, Default Router, and PPP IP 
address.

For the CX9201, CX94xx, and CX99xx:

If the controller does have a Network Interface Card (NIC) or built-
in NIC, then you must specify the PPP address. You may optionally 
specify an IP address and Subnet mask for the controllers NIC. If 
there is a workstation that has this controller listed in its database, 
the PPP address must match that specified in the controller; 
however, the IP address and subnet mask may be set to all zeros, if 
this controller is not a Remote Gateway, or set to match the settings 
in the controller.
If the controller does not have a NIC, then you must specify the 
PPP address. You may optionally specify the IP address, Subnet 
Mask for the controller or (preferably) you may specify all zeros for 
the IP address and Subnet Mask. If you are planning on adding a 
NIC to this controller at some point in the future and you want to 
reserve its IP address now, then you may specify its IP address on 
the controller itself, but the workstation must show an IP address 
of all zeros for this controller.

For the CX9640, CX9702, bCX1 Series:

The IP address defaults to 169.254.1.1 and the PPP address defaults to 
125.1.1.1

Note:  In Windows, you only have to enter the PPP address in the 
CyberStation in order for the controller to send the alarm into 
the workstation.

Step 3: If you are configuring a controller using a dumb terminal 
interface (CX9201, CX94xx, CX99xx) log out of the 
configuration setup screen. If you are configuring a controller 
using a web interface, save the changes and restart the 
controller.
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Step 4: After logging off the controller, you must physically press the 
controller’s Clear Memory Reset button for the IP 
information to be written to the controller properly.

Step 5: Once the controller has been reset, allow 1 to 2 minutes for the 
controller to go through its startup routine. After the startup 
routine is finished, verify that the IP configuration 
information was accepted and is configured correctly.

Changing the ACC Password

For enhanced security, you can change the ACC password. Changing 
the acc user’s password in the controller does not affect the remote 
communications operation. This simply protects from configuration 
logins by unauthorized users.

Testing and Verifying Communication

Once the CX is configured, test the modems and phone lines by using 
HyperTerminal from the Windows Workstation to dial into the 
controller. Be sure you use the modem that the network dialup will use 
on the workstation. This step is simply to verify that the hardware and 
phone lines are working properly before moving on.
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Connecting to the Controller Using Network Dialup

Follow the steps below to connect a controller using network dialup. 
From the Continuum Explorer:

Step 1: Open the Network Dialup object editor for the NetworkDialup 
object that was created for this remote site.

Step 2: On the General tab, click the Dial button. You may see a 
small amount of delay before the modem on the workstation 
actually begins to dial. Once the modem begins dialing, the 
Dial button changes to a Hang Up button.

Step 3: Click OK to close this window.
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Monitoring the Connection with Dialup Networking 
Monitor

The Windows Dialup Monitor appears in the system tray as an icon 
next to the system clock.

For troubleshooting and testing, it is a good idea to display the dialup 
monitor on the system tray to give you a visual display of carrier detect, 
transmit, and receive.

To view the connection details, double click on the icon. A status dialog, 
similar to the one below, appears.
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Verifying Communication to the Controller

Once a valid connection has been made using the network dialup 
object, verify proper connection to the controller.

Step 1: Attempt to pin the controller’s PPP address from the 
workstation with the dialup connection.

For controllers with only one Comm User port:
The Local IP Address will always be the address that was set up and 
the Remote PPP Client IP Address will be the local IP address plus 1.

For controllers with four Comm ports:
A unique PPP IP address is assigned to each comm port during system 
startup.For example, when a CyberStation dials into COMM 3, the 
controller automatically assigns the remote PPP client (in this case, the 
workstation9 an IP address using COMM 3’s local IP address plus 1. If 
the PPP base IP address for a controller is 20.20.20.1, the IP addresses 
assigned to each comm port and its remote PPP client would be as 
follows:

Table 4  Example Comm Port Assignments

Comm Port Sample IP Address

COMM1 Local IP Address 20.20.20.1

COMM1 Remote PPP Client IP 
Address

20.20.20.2

COMM2 Local IP Address 20.20.20.3

COMM2 Remote PPP Client IP 
Address

20.20.20.4

COMM3 Local IP Address 20.20.20.5

COMM 3 Remote PPP Client IP 
Address

20.20.20.6

COMM4 Local IP Address 20.20.20.7

COMM4 Remote PPP Client IP 
Address

20.20.20.8
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In this case, when the workstation dials into the controller with a 
modem on COMM3, the workstation’s PPP interface gets the PPP IP 
address of 20.20.20.6. The controller’s PPP IP address will be 
20.20.20.5.

Now, ping 20.20.20.5 from the workstation, you will see that the TD/RD 
lights will flash and the pinging of the IP address will return a 
response.

Step 2: Edit the remote controller. Notice that the Carrier Detect 
light in the monitor is green and the transmit and receive 
lights are flashing.

Step 3: Verify the controller is online.

Step 4: Perform a “teach” on the controller while connected.

Note:  It is also important that you edit the appropriate Comm Port on 
the controller and verify that the baud rate is set to 19200. By 
default, the database stores a value of 9600. If the default baud 
is not edited, the database will not be updated with the correct 
value that the controller has stored. Any future reloads of the 
controller would fail since there would be a discrepancy in the 
database and the controller for the Comm Port’s baud rate.

You may now add points, programs, IO modules, and doors to the 
controller. Refer to CyberStation Online Help for further information.
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Configuring a Remote Site with Multiple Controllers

Continuum Remote Communications supports dialup connections to a 
remote site of one or more CX series controllers. If the remote site 
consists of its own network of controllers, each with a Network 
Interface Card (NIC), the controller with the modem will serve as the 
gateway (or default router) for the other controllers on the remote 
network. For details on configuring the controller with the modem, 
refer to Creating the Remote Controller.

After establishing remote communications with the controller that has 
the modem, add any additional controllers on the remote network 
under the same Network Object, as follows:

Step 1: Create the additional controller(s) under the same network as 
the controller that has the modem.

Step 2: Set the IP Address in the same subnet with a unique host ID.

Step 3: Set the subnet mask.

Step 4: Leave the PPP IP address as 0.0.0.0

Step 5: Set the default Gateway to the IP address of the remote 
controller with the modem.

Step 6: Connect to the remote site.

Step 7: Edit the remote gateway controller and perform a Teach.

Step 8: Edit the other controller(s) on the remote subnet and verify 
that they are online.
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The additional controllers will be in the same subnet as the controller 
with the modem and do not require a PPP IP address. The additional 
controllers use the gateway controller’s IP address as their default 
router. The following table provides an example:

Table 5  Gateway and Additional Controllers

Controller IP PPP Subnet Mask Default 
Router

Infinity1 (modem 
attached, serves as 
gateway controller)

172.16.100.1 20.20.20.1 255.255.255.0 0.0.0.0

Infinity2 (no modem, 
default router is 
gateway controller)

172.16.100.2 0.0.0.0 255.255.255.0 172.16.100.1

Infinity3 (no modem, 
default router is 
gateway controller)

172.16.100.3 0.0.0.0 255.255.255.0 172.16.100.1
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Appendix A
Using the Plain English

Update Command

Overview

This section provides you with examples of different Plain English 
programs that can be created to utilize the Update command. The 
purpose of the Update command is to have the controller dial the phone 
number of a workstation and then send its alarms and events to the 
workstation.

Note:  For a bCX1 9640 controller, updates can be configured using the 
controller’s internal web pages. See the bCX1 Series Controller 
Technical Reference, 30-3001-890, and the controller’s online 
help.

The format of the Update command is as follows:

Update (user, phone_number, comport, timeout)

Replace user with the name and password of the user assigned to the 
workstation.

Replace phone_number with the phone number of the workstation.

Replace comport with the controller’s dial up comport number.
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Replace timeout with the number of seconds before a PPP session is 
initiated with the workstation.
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Sample Programs

Using the Update command will force the controller to dialout to the 
workstation and Send its alarms and events to the workstation. The 
connection is dropped when all alarms and events have been 
successfully sent up to the controller.
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Update Alarms Only Based on Alarm Count

Using the same base program noted previously, the NewAlarmCount 
variable could trigger the update program.

Note:  Simply using the Alarms keyword shows that there are active 
alarms in the system. 
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Update Events Only Based on AccessLog

Using a looping program, the update program can be used to update 
events when the AccessLog has reached a certain number of entries.
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Update Alarms and Events at an Interval

Using a FallThru program, force the controller to send its updates after 
a given time interval.
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Update Alarms and/or Events upon LAN Failure

The Update command may be used on regular LAN based controllers to 
ensure the delivery of Alarms and/or Access Events in the case of a 
Network failure. Alarms and/or Access Events can be delivered to a 
Workstation using PPP by writing an appropriate Plain English 
program that utilizes the “Update” keyword.

Note:  For a bCX1 9640 controller, updates can be configured using the 
controller’s internal web pages. See the bCX1 Series Controller 
Technical Reference, 30-3001-890, or the controller’s online help 
for further information.

Requirements

The controller requirements are as follows:

Controller must be version 1.53 or higher (1.2 or higher for the 
CX9702).
Controller must have the Redundant RAS option enabled.
Controller must be configured as a LAN Controller.
Controller must have an External modem or an Andover 
Continuum internal modem. Refer to Using External Modems for 
further information.
Controller must not be configured as a Remote Site Controller.
Workstation must have a modem attached and be configured to 
accept incoming connections. Refer to Configuring Windows to 
Receive Incoming Calls for further information.

Operation

With normal LAN Communications, alarms and events are 
automatically delivered to the Workstation(s). When a LAN segment 
fails and the controller is unable to communicate normally with a 
workstation, alarms and events are buffered at the controller.

During this period when the LAN is down, there are a variety of 
methods available to the Plain English programmer to determine when 
normal delivery of alarms and events has failed.
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Monitoring controller system variables, such as NewAlarmCount, 
AccessLog, and Workstation CommStatus, are acceptable indicators. 
Once it has been determined that alarms and events are being buffered 
at the controller due to a network outage, it is incumbent upon the 
programmer to determine the scheme of when to issue the “Update” 
command to deliver alarm and/or event information to the workstation.

This scheme could be based on the number of Events in the AccessLog, 
the NewAlarmCount and Alarm system variables, the amount of time 
passed since the Worksation CommStatus has changed from Online to 
Offline, or various combinations of all of these factors.
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Example Plain English Program
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Using External Modems

Comm Port and Modem Connections

If you are going to use an external modem, connected to a comm port of 
a controller, you need to build a cable to go from the controller’s comm 
port to the modem’s connector. The following is a table of the required 
pin connections.

Table 6  Comm Port and Modem Connections

Controller Pin 
Numbers

25 Pin Serial 
Connector Pin 
Numbers

9 Pin Serial 
Connector Pin 
Numbers

8 3 TD 2 TD

7 6 DSR 6 DSR

6 2 RD 3 RD

5 7 RTN (ground) 5 RTN (ground)

4 4 RTS 7 RTS

3 8 DCD 1 DCD

2 5 CTS 8 CTS

1 20 DTR 4 DTR
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Note:  The cable that ships with the controller is a direct connect cable 
(null modem) for connecting two like Date Terminal Equipment 
devices (DTE to DTE). To connect an external modem (Data 
Communications Equipment) to a commport (DCE to DCE) you 
must build an appropriate cable.

The following illustration indicates the pin numbers as they are viewed 
from the outside of the connector on the controller.
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Program for US Robotic External Modem

If your remote controller is to dial in to a CyberStation using a US 
Robotic Courier V.Everything external modem, then you must load a 
Plain English program onto that remote controller to initiate 
communication with CyberStation. The following looping program is an 
example:
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Appendix C
Troubleshooting

This appendix provides troubleshooting information for remote access 
issues. The topics are arranged in a frequently asked questions format.

Why can’t I connect to my remote site?

Make sure that the baud rate setting of the comm port you are using 
matches that of the remote site. Check the Workstation’s modem 
properties page, port setting, and the controller’s comm setting. The 
optimal setting is 19200 bps. Also make sure that your controller’s 
DefaultBaud attribute is set to 19200 (example: set COMM3 
DefaultBaud = Baud19200).

Check the Phonebook Entry in the NetworkDialup object of Continuum 
and make sure that the number you are dialing is correct.

Ensure that you do not have “Proxy Server” enabled on your PC. 
This may cause contention issues.
Ensure that the modem installed at the controller has been 
initialized. After the controller has been configured, go to the 
command prompt and issue: Initmodem(comm3)
Confirm that dialup to the controller can be established from 
Windows Dialup Networking.
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Why don’t I get alarms or events while I have an active connection between the 
CyberStation and the remote site?

Check the Continuous Polling attribute in the Networkdialup object 
editor in Continuum; it should be 1, 3, or 5 in order to receive alarms 
and/or events while a connection is active. When the continuous polling 
interval is set to 0, CyberStation will receive alarms only upon dialup, 
not during contiguous connection.

Why am I not receiving alarms or events from my remote site(s) using the 
“Update” keyword?

Verify that you created a Windows User and granted that user dial-
in privileges in the Incoming Call Object.
Ensure that the InfinitySystemVariable “EventLogSize” is set to 
10,000 so that you can receive Access Events in the Event Viewer. 
It is also important that the AccessServer system variable be set to 
the EnergyNet ID of the Controller. 
Verify in Remote Access Configuration, under Network setup, the 
following:

Step 1: Dial out Protocol is set to PPP-TCP/IP only.

Step 2: Number Properties - Encryption Settings: Set to Typical.

Step 3: In Incoming Connection Object - Check the specified IP is 
correct.

Check that the parameters of the Update Keyword Program is 
correctly setup.
Verify that you are a recipient of those alarms in the Event 
Notification.
Check the NT Event Viewer under Start, Programs, Administrative 
Tools, and Event Viewer to see if any error was logged.
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Why won’t my modem receive or initiate calls?

You must execute a Modem Initialization of External Modems (third 
party - on the remote site).

Use Windows HyperTerminal to check the modem. Verify that 
Windows recognizes your modem and that you can dial out using the 
HyperTerminal program. Use the following steps to check the modem:

Step 1: Click Start, select Programs > Accessories > 
HyperTerminal.

Step 2: When the New Connection Wizard is displayed, click 
Cancel.

Step 3: On the File menu, click Properties, and then click the 
modem you want to test to select it in the Connect Using list.

Step 4: Click Configure, verify that your modem is set to use the 
correct port, and then click OK. 

Step 5: Type AT in the HyperTerminal window, and then press Enter.

If AT is displayed in the HyperTerminal window as you type it and OK 
is displayed after you press Enter, the HyperTerminal recognizes the 
modem properly.

If AT is not displayed as you type it or if OK is not displayed after you 
press Enter, review the previous steps above to verify that your 
modem is installed properly in Windows.

Step 6: Verify that your modem can dial out using HyperTerminal. On 
the File menu, click NewConnection, and then follow the 
instructions on your screen.

Step 7: Click Dial. If the modem’s speaker is enabled, you should hear 
a dial tone and the sound of the modem dialing the phone 
number.
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What does this Windows error message mean?

The following table contains Windows error messages and the 
corresponding explanation.

Table 7  Windows Error Messages

Error Message

600 An operation is pending.

601 The port handle is invalid.

602 The port is already open.

603 Caller’s buffer is too small.

604 Wrong information specified.

605 Cannot set port information.

606 The port is not connected.

607 The event is invalid.

608 The device does not exist.

609 The device type does not exist.

610 The buffer is invalid.

611 The route is not available.

612 The route is not allocated.

613 Invalid compression specified.

614 Out of buffers.

615 The port was not found.

616 An asynchronous request is pending.

617 The port or device is already 
disconnecting.

618 The port is not open.
100 Schneider Electric



Appendix C: Troubleshooting
619 The port is disconnected.

620 There are no endpoints.

621 Cannot open the phone book file.

622 Cannot load the phone book file.

623 Cannot find the phone book entry.

624 Cannot write the phone book file.

625 Invalid information founding the 
phone book.

626 Cannot load a string.

627 Cannot find key.

628 The port was disconnected.

629 The port was disconnected by the 
remote machine.

630 The port was disconnected due to 
hardware failure.

631 The port was disconnected by the 
user.

632 The structure size is incorrect.

633 The port is already in use or is not 
configured for Remote Access 
dialout.

634 Cannot register your computer on 
the remote network.

635 Unknown error.

636 The wrong device is attached to the 
port.

Table 7  Windows Error Messages

Error Message
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637 The string could not be converted.

638 The request has timed out.

639 No asynchronous net available.

640 A NetBIOS error has occurred.

641 The server cannot allocate NetBIOS 
resources needed to support the 
client.

642 One of your NetBIOS names is 
already registered on the remote 
network.

643 A network adapter at the server 
failed.

644 You will not receive network 
message popups.

645 Internal authentication error.

646 The account is not permitted to log 
on at this time of day.

647 The account is disabled.

648 The password has expired.

649 The account does not have Remote 
Access permission.

650 The Remote Access server is not 
responding.

651 Your modem (or other connecting 
device) has reported an error.

652 Unrecognized response from the 
device.

Table 7  Windows Error Messages

Error Message
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653 A macro is required by the device 
was not found in the device .INF file 
section.

654 A command or response in the device 
.INF file section refers to an 
undefined macro.

655 The <message> macro was not found 
in the device .INF file section.

656 The <defaultoff> macro in the device 
.INF file section contains an 
undefined macro.

657 The device .INF file could not be 
opened.

658 The device name in the device .INF 
or media .INI file is too long.

659 The media .INI file refers to an 
unknown device name.

660 The device .INF file contains no 
responses for the command.

661 The device .INF file is missing a 
command

662 Attempted to set a macro not listed 
in the device .INF file section.

663 The media .INI file refers to an 
unknown device type.

664 Cannot allocate memory.

665 The port is not configured for Remote 
Access.

Table 7  Windows Error Messages

Error Message
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666 Your modem (or other connecting 
device) is not functioning.

667 Cannot read the media .INI file.

668 The connection dropped.

669 The usage parameter in the media 
.INI file is invalid.

670 Cannot read the section name from 
the media .INI file.

671 Cannot read the device type from the 
media .INI file

672 Cannot read the device name from 
the media .INI file.

673 Cannot read the usage from the 
media .INI file.

674 Cannot read the maximum 
connection BPS rate from the media 
.INI file.

675 Cannot read the maximum carrier 
BPS rate from the media .INI file.

676 The line is busy

677 A person answered instead of a 
modem.

678 There is no answer.

679 Cannot detect carrier.

680 There is no dial tone.

681 General error reported by device.

682 Error Writing SectionName.

Table 7  Windows Error Messages

Error Message
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683 Error Writing DeviceType.

684 Error Writing DeviceName.

685 Error Writing MaxConnectBPS.

686 Error Writing MaxCarrierBPS.

687 Error Writing Usage.

689 Error Reading DefaultOff.

690 Error Empty INI File.

691 Access Denied because username 
and/or password is invalid on the 
domain.

692 Hardware failure in port or attached 
device.

693 Error Not Binary Macro.

694 Error DCB Not Found.

695 Error State Machines Not Started.

696 Error State Machines Already 
Started.

697 Error Partial Response Looping.

698 A response keyname in the device 
.INF file is not in the expected 
format.

699 The device response caused buffer 
overflow.

700 The expanded command in the 
device . INF file is too long
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701 The device moved to a BPS rate not 
supported by the COM driver.

702 Device response received when none 
expected.

703 Error Interactive Mode.

704 Error Bad Callback Number.

705 Error Invalid Auth State.

706 Error Writing INITBPS.

707 X.25 diagnostic indication.

708 The account has expired.

709 Error changing password on domain.

710 Serial overrun errors were detected 
while communicating with your 
modem.

711 RasMan initialization failure. Check 
the event log.

712 Biplex port is initalizing. Wait a few 
seconds and redial.

713 No active ISDN lines are available.

714 Not enough ISDN channels are 
available to make the call.

715 Too many errors occurred because of 
poor phone line quality.

716 The Remote Access IP configuration 
is unusable.
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717 No IP addresses are available in the 
static pool of Remote Access IP 
addresses.

718 PPP timeout.

719 PPP terminated by remote machine.

720 No PPP control protocols configured.

721 Remote PPP peer is not responding.

722 The PPP packet is invalid.

723 The phone number, including prefix 
and suffix, is too long.

724 The IPX protocol cannot dial-out on 
the port because the computer is an 
IPX router.

725 The IPX protocol cannot dial-in on 
the port because the IPX router is 
not installed.

726 The IPX protocol cannot be used for 
dial-out on more than one port at a 
time.

727 Cannot access TCPCFG.DLL.

728 Cannot find an IP adapter bound to 
Remote Access.

729 SLIP cannot be used unless the IP 
protocol is installed.

730 Computer registration is not 
complete.

731 The protocol is not configured.
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732 The PPP negotiation is not 
converging.

733 The PPP control protocol for this 
network protocol is not available on 
the server.

734 The PPP link control protocol 
terminated.

735 The server rejected the requested 
address.

736 The remote computer terminated the 
control protocol.

737 Loopback detected.

738 The server did not assign an address.

739 The remote server cannot use the 
Windows NT encrypted password.

740 The TAPI devices configured for 
Remote Access failed to initialize or 
were not installed correctly.

741 The local computer does not support 
encryption.

742 The remote server does not support 
encryption.

743 The remote server requires 
encryption.

744 Cannot use the IPX net number 
assigned by the remote server. Check 
the event log.

752 A syntax error was encountered 
while processing a script.
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